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Welcome to AceBackup! 
The AceBackup backup tool helps you to store your confidential data in a safe way. One 
of the most significant features of AceBackup is the ability to store files on FTP servers, 
as well as on local storage devices (hard drives, floppies, ZIP, JAZZ or MO disks, LAN 
folders, or any other writable devices). The user interface is easy to use, and you can 
store and restore files as in the Windows Explorer. 

Other AceBackup features: 

Use the AceBackup wizards to create backups of your data on a chosen volume and 
restore them as easily. 

AceBackup implements several strong encryption algorithms to hold your data securely. 
If you decide to store your backup on a remote FTP server, nobody can access its internal 
data during direct transfers on the server. 

AceBackup projects can be scheduled to run regularly to keep your data up to date. The 
program scans all local folders of the project and, if it detects new or changed files, they 
are processed automatically.  

AceBackup supports a number of versions for storing and restoring files. 

Restoring files of an AceBackup project is very easy. The target can be either the original 
or any other location.  

 





 

What is new... 

What's new in version 3? 
• AceBackup is now completely compatible with Windows Vista!  

• The usability has been drastically increased. AceBackup can now be used intuitively 

by everybody.  

• New wizards for backup and restore facilitate working with AceBackup.  

• AceBackup is now able to backup files, although they are used exclusively by other 

applications on the computer.  

• New backup destination „Network Resource“. This enables you to process backups 

on network resources and at the same time have the secure authentication.  

• Improved drag & drop of files in a backup project.  

• Support of SMTP servers with SSL/TLS authentication for sending status messages.  

• Many more improvements and extensions!  

 

What is new in version 2.1? 
• The new Project Manager simplifies your project management (creating new 

projects, opening existing projects, deleting projects and changing properties). 

• Windows Explorer integration - you can now add files and entire folders to an 

AceBackup project and process the project from the Windows Explorer context 

menu by only one mouse-click. 

• Improved support of CD/DVD backup projects: Easily backup your data on 

CD/DVD. All current CD/DVD-ROMs are supported, the reading and/or writing 

speed can be modified. 
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• Improved New project wizard: All the required project settings are directly specified 

with predefined and recommended values. 

• With the help of a new dialog box you can specify file name extensions of files that 

are to be added to your project. 

• New backup format "As Is" - Files are stored to the backup volume without 

encryption and compression under the same name as on the disk. 

• Improved file encryption/compression - small files of less than 8 MB are encrypted 

in memory and huge files are encrypted by using a temporary swap file.  

• Customizable location of project and log directories.  

• More flexible email notification: The sent log file may include failed items only or 

the entire report. 

• Correction of bug which fragmented file names if original file included special 

characters like e.g. @, `, etc. 

 

What is new in version 2.0 
• Direct Backups on CD and DVD!  

• Simultaneous backup on local storage devices as well as on remote FTP servers!  

• Different compression levels for an AceBackup project are available!  

• External applications that should be executed before or/and after processing an 

AceBackup can be specified! 

• Strong encryption of files content as well as of file names!  

• Manage several backup volumes in a project file 

• AceBackup projects may have several volumes with different target locations - 

simultaneous backup on local storage devices as well as on remote FTP server!  
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• New user interface with 3 different themes!  

• Automatic dial-up before connecting to media on a remote FTP server as well as 

automatic hang-up after disconnection!  

• New function "Smart-Restore"!  

• Detailed reports!  

• New tutorial and extended help!  

• Many other improvements and optimizations!  

   
   

 

 

 





 

User interface 

Main window 
The main window is divided into two sections: Local System and Backup Project.  

1. Local folders 

The folders on your computer are displayed. Use the local folder tree to add 

items to your project. To see the content of a folder select it in the list and you 

will be shown its content in the window to the right.  

2. Backup project 

Here your AceBackup project as well as the files and folders which you want to 

backup are displayed. If you select a folder in the project folder tree its content 

will be shown in the window to the right. You will find the most important 

functions in the project toolbar above the project view.  

 

Project toolbar 

Here you find buttons to quickly access frequently used commands.  

• New  

Opens the New project wizard. 

• Open 

Opens a saved project file. 

• Close 

Closes the currently opened project. 

• Backup 

Allows you to backup and to add new files by opening the Backup Wizard. 

• Restore 

Allows to you restore your project by opening the Restore Wizard.  
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• Refresh 

Scans the local system for updates files.  

• Verify 

Opens the Verify Project wizard which adds and removes files which are in the 

project, but not on the backup volume and vice versa.  

 

Local folders 

The folders on your computer are displayed. Use the local folder tree to add items to your 
project. 

 

Local file list 

The content of the folder selected in the local folder tree is displayed. Use the local file 
list to add items to your project. Click the corresponding header to sort the list by 
columns (name, size, type, modified).  

 

Project folder 

The folders of your AceBackup project are displayed. If you select a folder in the project 
folder, the content is displayed in the list of the project items. 

 

Project item list 

The content of the project folder selected in the project folder tree is displayed. 
AceBackup uses color codes, so that it becomes easier for you to identify project items. 
The default colors are: 

Blue for items to back up 

Green for items to restore 

Gray for items to be deleted from the project. 

Note that you can change the default colors in the Options dialog box. If you wish to sort 
the list by columns, click on the corresponding column heading.   
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Main menu 
In the menu bar of AceBackup you find the following options. To get more information 
about the sub-menus, click on the corresponding menu. 

File menu•  

Edit menu•  

View menu•  

Project menu•  

Tools menu•  

Help menu•  

 

File menu 

In the File menu you have access on these options: 

• New 

Creates a new AceBackup Project. Refer to the New project wizard section to learn 

more about creating a new project.  

• Open 

Opens an existing AceBackup project. 

• Reopen 

Quickly accesses several recently used AceBackp projects. 

• Save 

Saves the current project. 

• Save as 

Saves the current project under a different name. 

• Close 

Closes the current project. 
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• Delete 

Marks the items that are selected for deletion in the project folder tree or the project 

list. Note that these items are not deleted, until you click the Process button in the 

Project menu. 

• Rename 

Renames the selected item.  

• Properties 

Displays the properties of the selected items. You can use this command for your 

local files and folders, as well as for your project items. 

• Exit 

Exits AceBackup. 

 

Edit menu 

In the Edit menu you have access on these options: 

• Copy 

Copies the selected items to clipboard. You can later paste these items either into the 

local file list or into your project. Note that you can only copy from the local file list. 

• Paste  

Pastes items from clipboard into the current file list.  

• Select All 

Select all items of the current list. 

 

View menu 

In the View menu you have access on these options: 

• Local System 

Shows or hides the local system. 
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• Toolbar>Project 

Shows or hides the project toolbar. 

• Toolbar>Local System 

Shows or hides the local system toolbar. 

• Toolbar>Volume 

Shows or hides the selected volume in the project toolbar. 

• Status bar 

Displays the status bar. 

• Go >up 

Goes up one level in the folder hierarchy. You can use this command for your local 

files and folders, as well as for your project items. 

• View project log 

Displays the project log file. The project log contains information about all the 

operations performed on this project. Note that you might need to make the 

required settings to your project to log all the operations. 

• Refresh 

Refreshes the content of your file list or project item list. You can use this 

command for your local files and folders, as well as for your project items. 

 

Project menu 

In the Project menu you have access on these options: 

• Backup Wizard 

Starts the Backup Wizard. 

• Restore Wizard 

Starts the Restore Wizard.  
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• Verify 

Displays the Verify project wizard. 

• Import 

Displays the Import project wizard. 

• Process>Process all 

Performs all backup, delete and restore operations at once.  

• Process>Backup 

Creates a backup for all selected project items. 

• Process>Delete 

Deletes all selected project items. 

• Process>Restore 

With this command you can restore all selected project items. 

• Reset updates 

If you change your project, you can restore the original state of the project (that is 

the state after it was opened). 

• Connect 

Connects to the backup volume. The status bar displays the actual status of 

connection. 

• Disconnect 

Disconnects from the backup volume.  

• Properties 

Displays the Project properties dialog box. 

HINT: Note that you can still work on your project offline, but you cannot save 
your data to the backup media, until you reconnect. 

Tools menu 

In the Tools menu you have access on these options: 
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• Options 

Displays the Options dialog box. Use the Options dialog box to change program 

settings. 

 

Help menu 

In the Help menu you have access on these options: 

• Help topics 

Displays the program help. 

• More Products 

Opens the websites of other AceBIT products. 

• Update Manager 

Searches for updates for your product. 

• About AceBackup 

Displays information about AceBackup, e.g. the version number. 

 

Project properties 

General tab 

Use the Name edit box to change the project name. 

The Encryption label shows the encryption type. Click the Modify button to change the 
security settings. 

At Compression you find the compression options. 

The Size label shows the size of the project and the Content label shows the number of 
files and folders of the project. 

Use the Included file extensions and Excluded file extensions boxes to select the type of 
files to be included in or excluded from the project. Enter a list of file types, separated by 
semicolon, into either of them. 
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EXAMPLE 
If you enter *.a* into the Included file extension box and *.??c in the Excluded 
file extension box, 
*.aba  - will be included, since it matches the included mask,  
*.baa  - will not be included, since it does not match the included mask,  
*.abc  - will not be included, since it matches the excluded mask.  

   

Use the Default action on name collision drop-down list to choose the action AceBackup 
will take by default, if you place a file into a project folder that already contains a file 
with the same name. 

• Replace existing files - to always replace existing files.  

• Update older files only - to replace existing files, only if the new files have a more 

recent timestamp.  

• Create a new version - to create a new file version, preserving both the new and the 

old file copies.  

Note that this property determines the default setting for each new project item you add. 
You can override this property for each item separately. For more details, refer to the 
Project item properties. 

  

Volume tab 

The Volume tab displays information about the volume on which your data is stored. The 
path is the same as defined in the New project wizard. 

Note that you cannot change the volume type, and the server host name (in case of an 
FTP server), while your project is created. 

On the Volume tab you can select your backup destination. Click the Add button to 
indicate a new volume or a new path. In the following dialog box in the System field, you 
can select between Local System, FTP server, CD/DVD drive and Network Resource. 
By clicking the Settings button you can change the Internet settings. If you wish to create 
your backups on CD or DVD, indicate the drive of your CD writer. After that the 
application recognizes the model and the CD writer's writing speed automatically. 

In the drop-down list Synchronization Mode you can select between All volumes are 
synchronized and All volumes are independent. If you select option All volumes are 
synchronized, the same content is saved on all volumes. If you select All volumes are 
independent, you can save diverse contents on all volumes.   
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Advanced tab 

Mark the Maintain log file checkbox to enable AceBackup to log all the operations 
performed. By default, AceBackup stores the log files in the Report subfolder of its 
program directory. You can also mark the Send report via e-mail checkbox to enable 
AceBackup to send a report via e-mail. Choose one of these options: send e-mail after 
each operation or only after failed operations.  

NOTE: Do not forget to enter your e-mail address in the Options dialog 
box.  

In the External Applications section you can indicate a batch file you have written, 
which is supposed for example to exit the running server application. Indicate the path of 
this file in the field Before processing, and select a time period. In the field After 
processing indicate the batch file which is supposed to run the server application again. 

You can configure AceBackup to perform operations, such as backing up or updating 
your project according to a schedule. To add, edit or remove a scheduled task, click the 
Edit button. For more information, refer to the Task scheduling section. 

   

Project item properties 
The Project item properties dialog box displays information concerning the project items. 
You can edit the properties of the project items. To display the item properties, select an 
item in the project list and click Properties from the File menu. 

 

General tab 

The Type label shows the type of your file or files. 

The Added label shows the date and time, when the file was first added to the current 
AceBackup project. Note that this label is only available, if a single file or folder is 
selected. 

The Modified label shows the date and time of the last modification of the file. Note that 
this label is only available, if a single file is selected. 

The Size label shows the size of your file or files in the AceBackup project. The real size 
of the files can be different, since AceBackup uses file compression to save space. If you 
have selected several items, this label displays the size of all selected items and subitems. 

The Location label shows the location of the item in the current AceBackup project. Note 
that this label is only available, if a single file or folder is selected. 
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The Original size label shows the size of your file. Note that this is only available, if a 
single file is selected. 

Use the Collision list to choose the action AceBackup will take, if you place a file with 
the same name over the selected file. 

• Replace existing  - to use the new version.  

• Update older files only - to use the new version only if it has a more recent 

timestamp.  

• Create a new version - to create a new file version - to preserve the new and the old 

file copies.  

Note that this option is only available, if you have selected a single file or folder. 

The Original location label shows the location of the item on your computer. Note that 
you cannot modify this property. 

NOTE: You can select a default setting for newly added files in the Project 
properties dialog box. 

  

Versions tab 

Note that the Versions tab is only available, if you have selected a single file from the 
project list. 

The Available versions list shows all file versions that are available. Select a version and 
click the Restore button to save the selected version to a specified folder. Click the Open 
button to open the selected file version. AceBackup opens the file as if it was opened 
from your local system. Click the Delete button to delete the selected version. 

Note that you are not deleting the project item itself, but one of its versions. You 
can only delete versions if there is more than one version available in the project. 

Report 
The Report window shows the log that was generated by AceBackup after a backup or 
restore operation. Normally, you see this window only if an error has occurred. 

You can print the report by clicking the Print button, or you can save the report to a file by 
clicking the Save as ...option. 
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On the right, at View, you can select if you wish to display all operations or only those 
that failed. 

 

Security settings 
If you click the Modify button under Encryption in the ... properties dialog box, the 
Security settings dialog box opens, where you can change the security settings of the 
current project. 

Use this dialog box to change the security settings of the current project. If you wish to 
change the encryption method and/or the password, enter the old password into the Old 
password box. 

Use the Encryption drop-down list to select a new encryption method, and enter a new 
password in the New password box. Confirm the new password by re-entering it into the 
Verify password box.  

1. WARNING: Changes to the encryption method or password will only apply to 

newly added files. All files that are already stored on your backup volume will keep 

the old encryption settings. Therefore, restoring files may require different 

passwords and/or encryption methods. To avoid such situations, it is recommended 

not to use different passwords and/or encryption methods within the same project. 

Mark the Store password checkbox, if you do not wish to enter the password every time 
you open the project. 





 

Working with AceBackup 

Working with your projects 

Create projects 

Before you can start working with an AceBackup project, it is necessary to create one. 

 

Add files and folders 

Select a file or folder from the local file list and drag and drop it to the project view. For 
more details, refer to the Adding items to your project section.  

 

Backup 

Use this command to perform the actual transfer of your data to the backup volume using 
the Backup Wizard. 

 

Restore 

Use this command to perform the actual transfer of your data from the backup volume 
onto your computer using the Restore Wizard.  

 

Delete 

Use this command to delete the files or folders from your backup volume. 

 

Reset 

To discard the changes you made to the project, select Reset updates from the Project 
menu. 

   

Creating a new project 
To start working with an AceBackup project, it is necessary to create a new project. Click 
New in the File menu or the New button on the project toolbar. The New project wizard 
opens. 
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Add the files and folders to the project per drag & drop or by opening the Backup Wizard 
from the Project toolbox or Project menu. 

 

New project wizard 
The New project wizard helps you to create a new AceBackup project. Click the Next 
button to follow the wizard steps. 

 

Welcome 

Enter the project name into the Project name box. 

In addition, define the location of your backups. Click the Add button to indicate a new 
volume or a new path. In the following dialog box in the System field, you can select 
between Local directory, FTP server, CD/DVD drive and Network Resource.  

For  backups on the Local System, specify the path of the folder where you wish to store 
your data. For Network Resources you can apart from the path also enter a user name 
and password. For backups on CD/DVD please select the drive on which the volume can 
be found.  

For FTP Servers, specify the following:  

• Address - the host name of the FTP server (e.g. ftp.myserver.com).  

• Port - the FTP port.  

• Directory - the folder on the FTP server, where you wish to store your data.  

• User - the login name.   

• Password - the password for your FTP connection.  

• Passive - mark this checkbox for a passive mode connection, clear it for an active 

mode connection.  

By clicking the Settings button you can change the Internet settings. 

In case you would like to use more than one volume for backup you can select between 
All volumes are synchronized and All volumes are independent. If you select option 
All volumes are synchronized, the same content is saved on all volumes. If you select 
All volumes are independent, you can save diverse contents on all volumes.  
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Security and Encryption Settings 

If you are storing confidential data, you can encrypt your data using one of the five 
encryption methods. Otherwise, please select Store Files "AS IS" at Files Format. 
Select an encryption method from the Encryption drop-down list and enter a password for 
encryption. AceBackup will prompt you to enter this password, whenever you try to 
restore your data from the backup volume. 

HINT: When choosing an encryption method you can define the security and 
encryption time. A higher bit encryption is safer, but takes more time to encrypt. 
Normally, you use the Rijndael 128-bit encryption. For higher security you can 
use a higher bit encryption. 

Mark the Hide checkbox to hide the password. Mark the Remember checkbox, if you do 
not want to enter the password every time you open the project. 

In addition, you can choose, to make the file name anonymous. Just check the option 
Automatically make anonymous file names on volume. 

 

To store your files in a compressed way so that they use less space on the volume, select 
a Compression from the list. Decide whether the speed is more important to you or 
whether you want the files maximally compressed.  

  

General Settings 

Use the Default action on name collision drop-down list to choose the action AceBackup 
will take by default, if you place a file into a project folder that already contains a file 
with the same name. 

• Replace existing files - to always replace existing files.  

• Update older files only - to replace existing files, only if the new files have a more 

recent timestamp.  

• Create a new version - to create a new file version, preserving both the new and the 

old file copies.  

Note that this property determines the default setting for each new project item you add. 
You can override this property for each item separately. For more details, refer to the 
Project item properties. 

21 



Manual AceBackup 3 

Use the Included file extensions and Excluded file extensions boxes to select the type of 
files to be included in or excluded from the project. Enter a list of file types, separated by 
semicolon, into either of them. 

EXAMPLE 
If you enter *.a* into the Included file extension box and *.??c in the Excluded 
file extension box, 
*.aba  - will be included, since it matches the included mask,  
*.baa  - will not be included, since it does not match the included mask,  
*.abc  - will not be included, since it matches the excluded mask.  

Mark the Maintain log file checkbox to enable AceBackup to log all the operations 
performed. By default, AceBackup stores the log files in the Report subfolder of its 
program directory. You can also mark the Send report via e-mail checkbox to enable 
AceBackup to send a report via e-mail. Choose one of these options: send e-mail after 
each operation or only after failed operations. In addition, define if you want to receive 
the complete report or only a failure report.  

 

Advanced settings 

You can configure AceBackup to perform operations such as downloading or uploading 
data according to a schedule. To add, edit or remove a scheduled task, click the Edit 
button. For more information, refer to the Task scheduling section. 

Moreover, you can indicate a batch file you have written which is supposed for example 
to exit the running server application. Indicate the path of this file here. Select the batch 
file which is supposed to run the server application again. 

In the last step of the wizard, please check if all options and settings are correct and click 
Finish to create the project.  

 

Volume settings 
You can select between Local system, CD/DVD drive, FTP server and Network 
Resource. By clicking the Settings button you can change the settings. If you wish to 
create your backups on CD or DVD, indicate the drive of your CD-writer. After that the 
application recognizes the model and the CD-writer's writing speed automatically.  
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Project properties 

General tab 

Use the Name edit box to change the project name. 

The Encryption label shows the encryption type. Click the Modify button to change the 
security settings. 

At Compression you find the compression options. 

The Size label shows the size of the project and the Content label shows the number of 
files and folders of the project. 

Use the Included file extensions and Excluded file extensions boxes to select the type of 
files to be included in or excluded from the project. Enter a list of file types, separated by 
semicolon, into either of them. 

EXAMPLE 
If you enter *.a* into the Included file extension box and *.??c in the Excluded 
file extension box, 
*.aba  - will be included, since it matches the included mask,  
*.baa  - will not be included, since it does not match the included mask,  
*.abc  - will not be included, since it matches the excluded mask.  

   

Use the Default action on name collision drop-down list to choose the action AceBackup 
will take by default, if you place a file into a project folder that already contains a file 
with the same name. 

• Replace existing files - to always replace existing files.  

• Update older files only - to replace existing files, only if the new files have a more 

recent timestamp.  

• Create a new version - to create a new file version, preserving both the new and the 

old file copies.  

Note that this property determines the default setting for each new project item you add. 
You can override this property for each item separately. For more details, refer to the 
Project item properties. 

23 



Manual AceBackup 3 

  

Volume tab 

The Volume tab displays information about the volume on which your data is stored. The 
path is the same as defined in the New project wizard. 

Note that you cannot change the volume type, and the server host name (in case of an 
FTP server), while your project is created. 

On the Volume tab you can select your backup destination. Click the Add button to 
indicate a new volume or a new path. In the following dialog box in the System field, you 
can select between Local System, FTP server, CD/DVD drive and Network Resource. 
By clicking the Settings button you can change the Internet settings. If you wish to create 
your backups on CD or DVD, indicate the drive of your CD writer. After that the 
application recognizes the model and the CD writer's writing speed automatically. 

In the drop-down list Synchronization Mode you can select between All volumes are 
synchronized and All volumes are independent. If you select option All volumes are 
synchronized, the same content is saved on all volumes. If you select All volumes are 
independent, you can save diverse contents on all volumes.  

  

Advanced tab 

Mark the Maintain log file checkbox to enable AceBackup to log all the operations 
performed. By default, AceBackup stores the log files in the Report subfolder of its 
program directory. You can also mark the Send report via e-mail checkbox to enable 
AceBackup to send a report via e-mail. Choose one of these options: send e-mail after 
each operation or only after failed operations.  

NOTE: Do not forget to enter your e-mail address in the Options dialog 
box.  

In the External Applications section you can indicate a batch file you have written, 
which is supposed for example to exit the running server application. Indicate the path of 
this file in the field Before processing, and select a time period. In the field After 
processing indicate the batch file which is supposed to run the server application again. 

You can configure AceBackup to perform operations, such as backing up or updating 
your project according to a schedule. To add, edit or remove a scheduled task, click the 
Edit button. For more information, refer to the Task scheduling section. 
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Adding items to your project 
To add files or folders to your project, select the related items either in the Local folders 
tree or in the local file list. Drag and drop the selected items to the project item list or to 
the Project folders tree. 

You can also copy the selected items and paste them to the project item list. You can also 
click the Backup button in the project toolbar to start the Backup Wizard or right-click 
an item and select Add to Backup.  

Project item properties 
The Project item properties dialog box displays information concerning the project items. 
You can edit the properties of the project items. To display the item properties, select an 
item in the project list and click Properties from the File menu. 

General tab 

The Type label shows the type of your file or files. 

The Added label shows the date and time, when the file was first added to the current 
AceBackup project. Note that this label is only available, if a single file or folder is 
selected. 

The Modified label shows the date and time of the last modification of the file. Note that 
this label is only available, if a single file is selected. 

The Size label shows the size of your file or files in the AceBackup project. The real size 
of the files can be different, since AceBackup uses file compression to save space. If you 
have selected several items, this label displays the size of all selected items and subitems. 

The Location label shows the location of the item in the current AceBackup project. Note 
that this label is only available, if a single file or folder is selected. 

The Original size label shows the size of your file. Note that this is only available, if a 
single file is selected. 

Use the Collision list to choose the action AceBackup will take, if you place a file with 
the same name over the selected file. 

• Replace existing  - to use the new version.  

• Update older files only - to use the new version only if it has a more recent 

timestamp.  

• Create a new version - to create a new file version - to preserve the new and the old 

file copies.  

25 



Manual AceBackup 3 

Note that this option is only available, if you have selected a single file or folder. 

The Original location label shows the location of the item on your computer. Note that 
you cannot modify this property. 

NOTE: You can select a default setting for newly added files in the Project 
properties dialog box. 

  

Versions tab 

Note that the Versions tab is only available, if you have selected a single file from the 
project list. 

The Available versions list shows all file versions that are available. Select a version and 
click the Restore button to save the selected version to a specified folder. Click the Open 
button to open the selected file version. AceBackup opens the file as if it was opened 
from your local system. Click the Delete button to delete the selected version. 

Note that you are not deleting the project item itself, but one of its versions. You 
can only delete versions if there is more than one version available in the project. 

 

Backup Wizard 
To add files which you would like to backup to your project, use the Backup Wizard.  

You can open it either via the Project menu or in the project toolbar via the Backup 
button. Furthermore, the wizard will automatically open, once you drag a file via drag& 
drop into the project.  

In the list you see the files which are to be added to your project and backed up.  Using 
the Add Folder button you can select folders to add. Single files can be selected via the 
Add Files button. Via the Delete button you can remove single items from the list.  

Note: Only checked items will be added to your backup.  

To start the backup immediately leave the option Process backup immediately checked. 
In case you only like to add items to your project for now uncheck the check box. By 
clicking Next you will start the process and AceBackup will add the files to your project.  
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Backup volume 
The Backup volume is the location in which the backup data is copied (backed up). 

As backup volume you can use, for example, a FTP server, a local folder, or a shared 
folder on your local area network. 

 

Restore Wizard 
To restore files which you have backed up with AceBackup, use the Restore Wizard.  

You can either open it via the Project menu or via the Restore button in the project 
toolbar.  

First, select all files and folders in the list which you would like to restore. In order to do 
this, check the according items in the list. Afterwards, click Next.  

In the next step of the wizard you can determine to which location you would like to 
restore the files.  

• Restore to original location: Adds the items to the original folder from which they 

were backed up.  

• Restore to alternate location: Restores the items to any other possible location.  

In case you do not want to restore all files, but only missing or additional files, check the 
Smart Restore option.  

To start to restore the items immediately, leave the option Process restoring 
immediately checked.  

Afterwards, click Next to start restoring.  

 

Password prompt 
The Password prompt dialog box appears, if you try to open an encrypted AceBackup 
project. 

Enter the password and click the OK button. To mask the password while typing, mark 
the Mask checkbox. Mark the Remember checkbox, if you do not want to enter the 
password every time you re-open the project. 
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Confirm local file replacement 
This dialog box prompts you to select the action that should be performed, if the file 
being restored has the same name as a file in your local folder. 

You can choose between the following: 

• Yes - to replace the local file,  

• Yes to all - to replace this and other existing local files,  

• No - to keep the local file,  

• Cancel - to keep the local file and stop the operation.  

 

File restoring error 
This dialog box opens, when you are trying to restore a file that has been encrypted with 
different encryption settings and/or password than defined in your project. 

To restore such a file, specify the encryption method and/or password that were originally 
used to backup this file. 

Click 

• Yes - to restore the file with the specified settings,  

• Yes to all - to restore this and other files with the specified settings,  

• Ignore - to ignore this file,  

• Abort - to stop the restoring process.  

To mask the password while typing, check the Mask box. 



 

Features 

File versions 
With AceBackup you can keep multiple revisions of your files: You can create backup 
copies of important data and keep track of the revision history of your files. 

 

How does it work? 

Normally, if you process an AceBackup project, AceBackup will overwrite older file 
versions with the new versions. However, if you use the save versions function, 
AceBackup will preserve the old and the new file version. 

 

Using the save versions function 

By default, AceBackup is configured to replace old file versions. To save versions, select 
the project items and open the Project item properties dialog box. Select Create a new 
version from the Collision drop-down list. AceBackup will then save new versions of the 
selected items, instead of replacing the old ones with the new ones. 

To set up the default settings of newly added files, select the project and open the Project 
properties dialog box. Go to the Advanced tab and select Create a new version from the 
Default action on name collision list. 

 

Task scheduling 
You can configure AceBackup to perform operations, such as backing up or updating 
your project according to a schedule. 

To add, edit or remove a scheduled task, open the Project properties dialog box, switch to 
the Advanced page and click the Edit button. 

AceBackup opens the Scheduled task properties dialog box. Switch to the Schedule page 
and set the necessary schedule settings. For more information, refer to the Windows 
online help. 

HINT: You can also configure scheduled tasks via the Windows Explorer. Just 
start the Windows Explorer and go to the Scheduled tasks folder. Locate the 
necessary task and double-click it. 
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Attention: If you wish to schedule a backup on a CD or DVD, make sure that a 
CD or DVD is inserted into the drive. 

 

Backups on CD or DVD 
AceBackup allows you to easily perform backup operations on CD or DVD. The 
application recognizes your CD writer and its writing speed automatically. You can use 
the following volume to burn on a CD or DVD: CD-R, CD-RW, DVD-R, DVD-RW.  

To perform backup operations on a CD or DVD, define the medium and the path in the 
dialog box Properties/Volume. 

Attention: If you wish to perform a scheduled backup operation on a CD or 
DVD, make sure that a CD or DVD is inserted in the drive.  

 

Import project wizard 
This wizard helps you to import an existing AceBackup project from your backup 
volume. 

NOTE: This feature is useful, if you have lost your project file, but the backed up 
data is still available on a remote server or a local drive or computer. 

On the Location of project files page of the wizard, enter the exact name of your project. 
Use the Volume on drop-down list to indicate where the data is located: on an FTP server, 
a local file, or LAN drive. Enter all the required information. The path is the same as 
defined in the New project wizard. Click the Next button. 

AceBackup searches for available files and folders, and displays a report. Click the Finish 
button to create the new project. 

 

Verify project wizard 
The Verify project wizard helps you to verify the consistency of the current project.  

EXAMPLES 
The wizard adds items that are on the backup volume, but not in the project file. 
The wizard removes files that are in the project, but not on the backup volume. 
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Click the Next button to start verifying. The wizard will synchronize the project, if it finds 
any difference between the project file and the current content of the project. 

HINT: The wizard will not verify, if files are changed on the local system, it 
verifies only if the files have the same content as in the project. For example, if 
the files text1.txt, text2.txt, text3.txt are present in the project file and the files 
text1.txt.nsz, text4.txt.nsz, text5.txt.nsz are present on the volume, after the 
verifying the files text1.txt, text4.txt, text5.txt are present in the project file, 
because the wizard removed the files which were not present on the volume, and 
added those files which could be found on the volume. 





 

Configuring AceBackup 

Options: Appearance 
Select the Appearance tab of the Options dialog box to modify the program appearance. 

 

User interface theme 

Here you can change the appearance of AceBackup.  

 

User interface language 

You can change the user interface language using the User interface language drop-down 
list at the bottom of the window. AceBackup currently supports English and German. 

  

Highlighting project items 

You can customize the way your project files and folders are highlighted. 

First select an item state from the Item state drop-down list:  

• Not marked - for items that are already backed up, and for which you do not want to 

perform any additional operations,  

• Back up - for items that are to be copied to the backup volume,  

• Restore - for items that are to be copied from the backup volume onto your 

computer,  

• Delete - for items that are to be deleted from the backup volume.  

Then you can choose the color for the selected item state using the Color drop-down list. 
You can also choose the font style by marking the Bold, Italics, Underline or 
Strikethrough checkboxes. 

 

Play sounds 

To receive an acoustic signal for every single action, check the box and click the button 
Configure Sounds to define the desired settings. 
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Show hidden files and folders 

Check this option to be able to see hidden files and folders as well.  

 

Options: Internet Settings 

Proxy/Firewall 

If your are connected to the Internet via a proxy server, specify the address (or host 
name) of the server. 

• Use default proxy settings - to use the default (Windows) settings of the server 

address and port. Click Modify to change the system settings.  

• Direct connection (no proxy) - if you are not connected via a proxy server.  

• Manual configuration - enter the address (or host name) of the server into the 

Address/Host name box and the port number into the Port box.  

 

Options: E-Mail settings 
Enter your e-mail address into the Address box. AceBackup will use it (if configured) to 
send reports after performing backup operations. Enter the e-mail address of the 
addressee into the Addressee field, and the e-mail address of the sender into the Sender 
field.  

To enable AceBackup to send e-mail messages, specify the e-mail server settings. Enter 
the address of your e-mail server into the SMTP box and the port number into the Port 
box. Some e-mail servers require that you login to its incoming mail account before 
sending an e-mail. Mark the Authentication required checkbox to login and enter the user 
name and password. 

In case your server requires an encrypted connection, you can select this option below 
and choose the correct TSL Level from the drop down list.  
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Options: Advanced 

Folders 

Here you can change the path for storing the log files and project files of AceBackup.  

 

CD/DVD drive 

Use the slider to to set the Read and Write Speed for a CD/DVD.  

 

Options: Volume 

For new project use as default 

In this section you can select if you wish to apply your last selected project settings for 
new projects or if you wish to apply the default backup settings. 

Default backup destination 

As default backup destination, you can select between  

• Local System: Indicate the path on the local system.  

• FTP server: Indicate Address, Port, Directory, User name and Password. For 

passive transfer check the box PASV mode. 

• CD/DVD drive  

• Network Resource 
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